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RELEASE NOTES

Kinetics 2.0 
Release August 2025 

The latest Carterra Kinetics and Epitope Analysis Software brings many exciting feature updates to enhance ease-of-use and improve the user 
experience when analyzing large data sets. 

Please carefully read the following notes before downloading for use. Additional details about the software and platforms can be found in the 
User Manual, available for download: https://carterra-bio.com/resource-category/user-manuals/

Changes Since Last Release 
Features  
	 • 2.0 is compatible with files from all Carterra instruments. 
	 • Calibration files can be exported from one analysis and imported into another.  Make sure to only do this when chips and buffers 	
	    have not been changed. 
	 • Crop can now be applied prior to calibration. 
	 • Custom referencing is supported for non-standard formatting of arrays. 
	 • Kinetics and Epitope now support calibration; response normalization over the full range of your data. 
	 • Kinetics supports the Excluded Volume Correction, in support of small-molecule applications. 
	 • NEW: kinetics screening tab. Customizable hit selection. 
	 • Steady State tab now support Y-axis data normalization.

Updates 
	 • "ROI position and ROI ID" nomenclature has been replaced with ROI. 
	 • Analyte filtering before calibration is now possible 
	 • Data sorting now first sorts on ascii, then numeric 
	 • Exclusion/inclusion of data in kinetics tab no longer causes the table to jump back to the beginning. Continue analyzing and curating 	
	    your data from where you left off after hiding/unhiding analyte/ligand pairs. 
	 • Exported tables are now labeled with units for all columns. 
	 • Exporting to Excel and SQLlite has been accelerated. 
	 • Files now open faster than ever, the application closes faster, fitting speed has been improved, and navigation is more fluid and 		
	    responsive. 
	 • Merge+save now reports the location of the saved file. 
	 • More user control of data display and export options in gears tabs. 
	 • Parameter precision now based on fit confidence. 
	 • Quantitation and surface prep arrays files have their immobilization phases broken up like capture kinetics for consistency. 
	 • Rendering speed has been enhanced. 
	 • Hardware rendering issues introduced by changes in Intel drivers have been resolved. 
	 • ROI map now fits in view. 
	 • Summary stats page now uses geometric mean to average the on- and off-rate data. The average KD is now reported as the ratio of 	
	    kd(geomean)/ka(geomean), not the average of the individual KD measurements. 
	 • Version 2.0 no longer supports .lsadata files. Files before ~June 2020 will need to be opened with legacy Kinetics or Epitope. 
	 • Parameter error analysis has been improved.
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Calibration and Excluded Volume Correction 
Note: At this time, the Calibration and EVC features are exclusive to the Carterra Ultra platform. 

Contents  
This protocol provides guidelines for designing and executing Calibration and Excluded Volume correction in Navigator software.

Calibration 
Calibration utilizes responses generated from twelve calibrant solutions spanning a range from low to high refractive index (RI) (relative to 
assay conditions). This procedure linearizes the ΔRU vs. ΔRI scale for all experimental and reference ROIs across the chip. Calibration should be 
performed for each experiment where the highest data quality is desired (single point screens, affinity/kinetics, epitope binning). This workflow 
can be performed as part of a wizard or set up manually by user.

Calibration solutions should be optimized for each experiment. Here are some suggestions:

low RI = 4.5 mL water or buffer-DMSO + 10.5 mL running buffer

high RI = 600 μL DMSO + 14.4 mL running buffer

Other solutions can be used in place of DMSO as a high RI component. For example adding 1,200 μL of 50% glycerol or 3 mL of 5 M NaCl will 
result in similar responses.

Utilizing Calibration option in Navigator: 
Automatic calibration is performed at the end of the experiment and takes approximately 45 minutes. This calibration procedure requires user 
to supply at least 7.5 mL of well-mixed high and low RI solution and an empty vial for mixing. Ultra will automatically generate and inject twelve 
mixed samples from the two provided solutions. Below are the steps for setting up automatic calibration:

1.	 Calibration option can be selected from the Setup tab of Experiment wizard.



Kinetics Release Notes 3

2.	 Proceed to Options tab to populate sample locations. Calibration requires selection of three positions with minimum capacity of 
7.5 mL (select from Sample block locations in A or B). The positions will be assigned in the order selected: high RI, low RI, mix. In 
example below positions used are B1 (high RI), B2 (low RI), and B3 (mix).

3.	 Prepare at least 7.5 mL of high and low RI solutions to include in B1 and B2, respectively. Place empty 15-mL vial into position B3.

Manual calibration setup: 
When using microplates in both Single Channel bays (or when user is unable to designate 3 large volume vials), automatic calibration is not 
possible. Calibration can still be performed by preparing calibration solutions manually and including them in the injection list. To perform 
manual calibration, follow these steps:

1.	 Do not select Calibration option from the Setup tab of Experiment wizard.

2.	 Prepare a set of twelve solutions by mixing various volumes of the high and low RI solutions as follows:
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3.	 Include minimum of 200 μL of each solution in the plate.

4.	 Add calibrant solutions to SC injections list at the end of the sample injections.

5.	 During data processing in Kinetics, highlight the 12 calibration injections, right click, and assign to group “Calibrants.”

Excluded Volume Correction (EVC) 
Note: At this time, the Calibration and EVC features are exclusive to the Carterra Ultra platform. 

EVC accounts for the refractive index shift that is observed between experimental and reference surfaces caused by the captured/coupled 
material in the experimental region taking up volume in the detection region that is unoccupied on the reference surfaces. More of those buffer 
component molecules fit in the reference region leading to a refractive index shift that is independent of any binding interactions. This effect is 
exaggerated by high coupling densities as well as the use of high refractive index solvents such as DMSO, though in principle is present in all 
experiments. This correction is important for low- and high-affinity interactions but is most critical when no kinetics are visible and the binding 
interaction and bulk-shift components become indistinguishable from each other. 
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EVC requires at least 6 solutions (recommended 7-12 solutions) with a minimum volume of 200 μL. Low and high RI solutions can be prepared 
similarly to what is described in the Calibration section. Ensure that EVC falls within the Calibration RI span. EVC solutions must be prepared 
manually and included in Injections list. Below is the suggested procedure for preparing 8 EVC solutions using the same low and high RI 
solutions as for calibration:

*Note the EVC 1 and 8 are mixes of low and high RI solutions, which allows them to stay within the Calibration range.

Below are the steps for setting up EVC:

1.	 Select EVC option in the Setup tab of Experiment wizard.
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2.	 Under Options tab in Excluded Volume Correction subtab, add a minimum of 6 EVC positions to Bay 1 or 2.

3.	 On Injections tab, add EVC solutions to the end of the injections list.
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Kinetics 1.9.2.4463 
Release May 2024 
	 • Features 
	 • Updates 
	 • Known Issues

Changes Since Last Release 
Features 
          • Misc 
	 • Updates made to application installer to recognize existing installed Microsoft C++ redistributables and simplify installation dialog. 
	 • Kinetics 1.9.2.4463 will be the last version to support the .lsadata file format.

          • File Opening and Saving 
	 • If files saved in previous versions are opened, caution message will appear about recommended best practices when working with  
	    the file in this latest version.

           • Data Tab 
	 • Reassignment of Analytes in right-click menu is restricted based on original assignment (Analyte or Immob) to avoid errors.

           • Processing Tabs 
	 • ROI map view now uses experimental coordinates indicating the actual placement of ROIs on the chip during the run. Note that for 	
	    previously processed files the ROI map will revert to a default layout. 
	 • ROI map is now draggable and zoom in/zoom out can be done by CTRL+ mouse wheel.
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           • Data Fitting 
	 • Fitting progress dialog now included when fitting data on the Kinetics>Kinetic Analysis tab.
                

 
 
 
 
 
	  
	 • Default ka fitting uses range of starting values to avoid fitting minima which impact accuracy of ka fits. 
	 • Users have option of instead checking ka box on Kinetics tab and assigning a specific ka starting value.

 
 
 
 
 
	  
	 • Show KD Units is now unchecked by default.

          • Analysis Tab 
	 • No new features.

          • Report Point Tab 
	 • No new features.

          • Data Export 
	 • Headers are no longer merged in the Excel export. 
	 • Analyte and Ligand Report Point tables are now separate tabs in Excel export. 
	 • With Show KD Units now unchecked by default, no units are included in the export tables.

Updates 
          • Misc 
	 • No updates.

          • File Opening and Saving 
	 • No updates.

          • Data Tab 
	 • Duplicate prints now correctly separated into discrete Link Groups. 
	 • Correction of bug allowing space to be appended at end of Ligand names. 
	 • Carryover of ligand names from previous experiments in block 1 resolved.

          • Processing Tabs 
	 • Corrections made to custom and global referencing options to ensure displayed referencing assignments are applied appropriately.

          • Data Fitting 
	 • T0 is now functional when analyzing previously analyzed files without requiring deselecting, fitting, then reselecting. Carterra still 	
	     recommends refitting processed files when opened in the latest builds to ensure most recent improvements are applied to the data.  
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	 • Fitting speed performance improvements implemented which reduce fitting steps by up to an order of magnitude. See chart below  
	    for examples of performance when fitting a 16-link group file on various PC types in Kinetics 1.9.1 vs. 1.9.2.

                                                                                      

	 • Flagging of data in the Steady State tab only highlights and no longer removes data from the view.

          • Analysis Tab 
	 • Issues with data not fully displaying on Isoaffinity chart have been resolved. 
	 • Errors when sorting on the Affinity tab have been resolved.

          • Report Tab 
	 • No updates.

Known Issues 
	 • Report point export tables for Immobilization are missing Bay information . 
	 • Data flagged as < 50% Rmax, kd below limit, and/or km below limit is not treated as Flagged in the Analysis tabs. 
	 • Characters or numbers other than numbers 1 through 432 added to the Global Reference in the Analyte and Ligand Processing tabs 	
	    will cause an error to appear. 
	 • When Normalization is applied in Steady State, chart autoscaling may not apply correctly and therefore scales should manually 		
	    defined. 
	 • However, in previously processed files, the ROI map will open with a default layout that is not consistent with the physical layout on  
	    the chip. Referencing relationships are correct. 
	 • When running Capture Kinetics without specifying prints, the data file will open with default names of Ligand 1, Ligand 2, etc., and 	
	    the ligand names will need to be manually added to the file.

Kinetics 1.9.1.4215 
Release October 2023 
 
Changes Since Last Release 
	 • Features. 
	 • Updates. 
	 • Known Issues.
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Features 
	 • Allow kd fitting for multichannel (immob) data. 
	 • Data displayed during multichannel rinsing phase. 
	 • Chart export now acounts for screen scaling. 
	 • Ability to correct sensorgram bulk shift. 
	 • Display data within analyte injection cycle. 
	 • Kinetic fitting routine code improvements. 
	 • Kinetics and Steady Stage pages, Array View tabs: make "Show ROI Position" and "Show Ligand Name" clicked on by default. 
	    Update Settings > Table Options > Display ROI to be Checked by Default. 
	 • Gear menu options to hide Ligand Name and ROI from Array View. 
	 • Add Global Referencing  to Analyte Processing Page. 
	 • KD header row moved in File>Excel Export to simplify table processing.

Updates  
	 • Link Groups not correctly delineating.                                                                                                                                                                           	
	 • Tiles in File>Export do not follow sorted order in application. 
	 • High residuals in some off-rate fits. 
	 • An unstable error appears when opening certain saved .kitx files. 
	 • Incorrect sorting option by ROI ID in the Kinetic Analysis, Global Analysis tables. 
	 • Analysis > Stats page: Axis data is clipped. 
	 • Incorrect behavior of "ka" gates on the Analysis > Iso-Affinity page. 
	 • The X and Y axis label size settings don't apply to the chart on the Analysis > Stats page. 
	 • The chart text size settings don't apply to the chart on the Analysis > Scatter Plot page. 
	 • The Inactive ligands are displayed in the "Analytes" tab on the Analysis > Stats page. 
	 • Application isn't updated dynamically after using the "Data Filter" option. 
	 • Experiments are not displayed on the charts on the Analysis pages when the experiment assigning to the Default group from the  
	    Inactive group on the Steady State page. 
	 • Sort order changed after experiments are assigned to the Inactive / Complex / Excluded Group in the Kinetic Analysis table. 
	 •"Copy All Data to Clipboard" Error on Kinetics > Array View. 
	 • Scatter plot pasted values dont match plot. 
	 • Data page: Font sizes do not change. 
	 • SQLite Export missing ResSd value from fitting results. 
	 • Cannot Copy/Paste into Analyte Processing > Referencing > Assignments Table. 
	 • Steady State > Global Analysis Table Missing "ROI" Column. 
	 • Quant Page - Report "[Concentration Value] <,> [Max/Min Allowable Concentration]" instead of ND. 
	 • After fitting on the steady state page some ligands with ND values are not colored as Inactive.

Known Issues  
	 • Fitting times increase as more fit variables/options are selected.  
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